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New Point Clouds Commands and Features 
• Automatic recognition of ground surface has been significantly improved; 

• Possibility to classify vegetation and objects at a given distance from the 

ground (or any other surface) has appeared; 

• Support of WGS84 coordinate system; 

• Significant corrections and improvements. 

Classification of Ground and Vegetation 

The command  Classification of Ground (NPC_CLS_GROUND) has been 

revised. 

Command Options on the “Properties” Bar 

Now the command options are displayed and configured not in the command 

line, but on the Properties bar. 

New command options: 

 

Filtration Based on Source Classes 

The command allows you to specify certain classes of points for the ground 
classification process. It can be useful if a cloud was earlier classified by these or 

those criteria. For example, to exclude from the recognition process the points of 

noise, man-made objects, etc. 

The Source classes parameter defines the classes of those points, that will be 

used for ground classification. Points of other classes will not be reclassified. The list 

opened by button  displays all classes of the current point cloud. 
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The Ground class parameter is the target class, which should be assigned to 

recognized points of the ground. 

 

The target class should coincide with none of the source classes, otherwise the 

command will stop ahead of time with an error message in the command line. 
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Automatic Calculating of Surface Detalization During Ground 
Classification 

Now the Cell size parameter is calculated automatically, based on the size of a 
point cloud in the drawing. As a rule, it should not be changed. In previous version 

of a program, the value of this parameter was taken from the Point clouds section 

of the Options dialogue. The Cell size defines the length of sides of square cells that 
divided surface of point cloud. The smaller the value, the more accurately relief 

elements are reflected. Parameter value is set in the units of drawing. 

Surface Irregularities 

We preserved the parameter Terrain angle, degrees – maximum angle of 

slope in degrees relative to XY plane in WCS. It can be measured at some 
characteristic area. Points on surfaces that exceed this angle will not be classified as 

ground surface points. 

 

 

 

Parameter Iteration angle, degrees to plane – maximum angle of deviation 

of local irregularities from the main direction of the ground surface. 
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Filtration by Distance from Ground Surface 

The Maximum distance parameter determines the maximum distance above 
the ground surface, above which points will not participate in the classification 

process and, therefore, will not be classified as ground points. The distance is 

specified in the units of drawing. 

 

Exclusion of False Surfaces 

A new parameter Maximum window size allows you to exclude low buildings 

and constructions with flat wide roofs from ground recognition. 
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It is necessary to find the widest low object and measure a half of its shorter 

side, increasing the resulting value by 20 percent. For each cloud the parameter 

should be set manually in the units of drawing. 

Note: correctly measured parameter Maximum window size is always larger 

than Cell size parameter. 

Classification of Vegetation 

The command is enhanced with the functional for classification of points 
(vegetation) by height above ground level. Set Yes for the Classify vegetation 

option, additional options will appear. 
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The command classifies points located in the given altitude range relative to the 

ground surface. Values are set in the units of drawing. 

 

Only ground surface points 
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Ground surface points with low vegetation points 

 

 

Ground surface points with average vegetation points 
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Ground surface points, points of low, average and high vegetation 

 

This procedure can be used not only to classify vegetation, but also to classify 
any objects by height from the ground surface: low constructions, high-rise buildings, 

power lines, pipes, etc. 

Creating Triangulation Mesh of a Surface 

In addition to ground surface classification, the command allows you to 

automatically construct its triangulation model as a mesh object. For this the value 

of Save ground model option should be Yes. 

In contrast to the triangulation mesh of ground surface created by  Create 
TIN command, this network is created with optimized edges. In the future the 

created triangulation mesh can be optimized by  Model Simplification 

command. 

New Commands and Improvements 

“Vegetation by Height” Command 

The functional of objects classifying by height above the surface is also put into 

a separate command  Vegetation by Height. 

The command has parameters identical to those described above. As the surface 

relative to which the classification will be made, it is necessary to specify the existing 
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triangulation mesh, for example, the one built earlier by the command 

 Classification of ground or  Create TIN. 

Filtration Based on Source Classes in the “Create TIN” 
Command 

The command  Create TIN (NPC_2D_TRIANGULATION) got new options 
that allow you to select particular point classes for creation of triangulation mesh 

based on them. The options are similar to ground classification command 

 Classification of ground (NPC_CLS_GROUND). 

Importing Clouds with WGS84 Coordinate System 

The possibility to import point clouds from LAS format with WGS84 coordinate 
system is added. Previously clouds with WGS84 coordinate system were imported 

with distortion. 

Changing Class for Visible Points Only 

A new command  Classification by class (NPC_CLS_CLASS) changes class 
for visible points only. Just cut a part of cloud containing required points with one of 

the Clip or Section commands and reclassify only visible points by specifying their 

source class. 

Coloring Clouds by “Compare Point Clouds” Command 

Now the command  Compare Point Clouds colors the cloud according to 

the normal direction (outside/inside) when comparing a cloud with triangulation 

ground surface. The cloud above TIN surface is colored in the spectrum from green 
to red, and below – from green to blue. It allows easily determine the position of 

points relative to the mesh (ground surface). 

In addition, the coloring of clouds was fixed when resetting clip after comparing 

their trimmed parts. 

Changes and Corrections 
• Fixed errors of graphics (widget) displaying when comparing clouds. 

• Correcting work of the command  Fit Cylinder (NPC_FIT_CYLINDER). 

• Fixed errors of comparison algorithm in video card. 

• Updated icons of cloud points classification commands. 
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Platform Features 
nanoCAD 3DScan 2.0 based on 20.1 version of nanoCAD platform. Thus, nanoCAD 

3DScan 2.0 gets all features of nanoCAD Plus, since 8.5 version. 

New Features of nanoCAD 10.0 Platform 
Key features of nanoCAD 10 platform are: new user interface style, compatibility with 
most DWG-CAD systems, speed and usability, checking drawings for standard 

compliance, new 2D-drawing and 3D-modeling functions, improved printing and 

much more. 

Increased Performance 

nanoCAD visual graphic system that is responsible for rendering 2D and 3D-graphics, 
has been updated to support the Microsoft DirectX 10 technology. This accelerates 

the processing time of drawings with large amount of text objects, hatches, blocks 

and other complex primitives, and reduces the size of memory used. 

DWG 2018 

nanoCAD 10 works directly with the latest version of DWG format. nanoCAD opens 

and saves drawing files without breaking their internal structure. This ensures the 
integrity of the built-in DWG format labels which can carry such characteristics as 

educational plot stamp, for example. 

User Interface 

A new ribbon-style interface provides modern ways of interaction with application. 

Instant switch between classic and ribbon interface makes work very comfortable. 

The ribbon structure was initially designed taking into account the ergonomics of the 

designer, but it does not limit the user in the possibilities of customizing their 
workspaces. In addition, a powerful mechanism of managing the ribbon interface 

allows you to instantly switch between different pre-installed workspaces without 

restarting the program. 

Interactive Tools in a Drawing Area 

Semi-transparent interactive tools placed in a drawing working area designed to 

manage views and visual styles. 

The Locator element intents for convenient navigation in a three-dimensional space: 

rapid dynamic change of orthogonal, isometric, combined and free views. Its orange-

dot marker shows current view orientation. 
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The View Control element at the top left of drawing workspace changes named view 

and visual style of a viewport. 

Checking Drawings for Standard Compliance 

10 version of nanoCAD can check drawings for standards compliance and fix found 

violations.  

There are a number of notification mechanisms that alerts user about violations of 
standards while opening, saving, printing drawing file. It is possible to fix any 

violation or stay it intact. 

Information on each standard violation that has been found, but not fixed, is stored 
in a drawing. It is possible to disable alerts on such ignored objects in subsequent 

checks of the drawing. 

Violations audit can be performed manually and automatically, for example during 

drawing export, save and print operations. 

Partial Auto-save 

From now on, only the modified DWG data is sent to the file during background 

autosave, that significantly reduce the time of this operation even on rich documents. 

Dynamic Blocks Extended Support 

Dynamic block processing was improved: nanoCAD completely supports property 

tables, insertion point management, dynamic blocks parameters correct processing. 

This ensures that most objects of this type are functioning correctly. 

New Drawing Objects and Commands 

• In addition to its own leader objects, nanoCAD can create and edit multileader 

objects, manage multileader styles. 

• Native DWG-tables creating and editing without conversion to nanoCAD-table 

is available. Managing DWG-table styles and conversion nanoCAD-table to 

DWG-table and vice versa. 

• 3D-polyline creation and editing. 

• A new Region command creates an object of a region type from 2D objects 

that form closed area. 

• The Stretch command use pre-selected vertices that makes working with the 

command more convenient. 

Transparency of a Layer 

The layers got the Transparency property. All objects with By layer transparency 

value will inherit the transparency from the layer that belongs to. 
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Third-party Formats Import 

Now it is possible to import WMF and EMF formats, as well as DGN – 2D/3D-format 

used by the Bentley Systems MicroStation design program. 

Multiple Reworks 

The next stage of program optimization was performed in this version of nanoCAD. 

The common list of realized wishes, corrected errors and the taken into account notes 
exceeded seven hundred points. However, beginning with the 10th version, nanoCAD 

stops supporting Windows XP due to the need to speed up graphics and overall 

increase the stability of the program. 

New Features of nanoCAD 11.0 Platform 

Incremental (Partial) Saving 

In addition to incremental (partial) autosaving implemented earlier, the incremental 

saving is added. This greatly accelerates saving of a large documents. 

You can manage incremental saving modes in the Save Documents section of the 

Options dialog. 

Undo-Redo 

The new version has a number of improvements in undo-redo functionality. 

Named Steps 

 

The names of the last operations (steps) are displayed in the Undo and Redo 

commands in the Edit menu (the classic interface). 

Multiply Undo/Redo 
The flyout arrows are attached to the Undo/Redo buttons on the Quick Access 

toolbar to undo/redo several actions at once. 

Please take a note that you cannot drop-down action history list in the command 
mode (when a command is running). In command mode these buttons perform 

internal undo/redo operations, if exists. 
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Optimization Performance 

Selection Set 
Performance is improved for comparing old and new selection sets. The speed is 
significantly increased for operation of selecting among other objects in existing 

selection set. 

Text Objects 
The mechanism of graphical representation of text objects is optimized. As a result, 

image regeneration speed is increased and the amount of used memory is reduced. 

Blocks 
Loading and regeneration a file with a large number of blocks was significally 

accelerated. 

Complex Objects Insertion 
The process of inserting complex objects into the model space was optimized, cursor 

freezing was fixed. 

Frozen Layers Optimization  
Increased performance of loading and working in a document with frozen layers. 

Ultra-remote Objects Optimization 
The problem of displaying distortion of a drawing elements at super large distances 
has gone into the past. You no longer need to regenerate the drawing when 

approaching objects that are far from the current location. 

OLE-objects 

New commands for working with OLE-objects are implemented. 

 

• The Insert OLE-object (INSERTOBJ) command allows you to insert linked or 

embedded OLE objects from another document. 

• The Open OLE-object (OLEOPEN) opens specified OLE-object for editing in its 
source application. A similar result can be obtained by double-clicking the OLE-

object in a drawing. 

• The Update Data Links (OLELINKS) command opens the Links dialog to 

update and modify links of OLE-objects. 

• The Update All Links (OLEUPDATEALLLINKS) command allows you to update 

all links for OLE objects in the document at the same time. 
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Scripts (.scr) 

A new way of automation is added - by using scripts. A Command Script is a text file 
with a .scr extension that contains a set of instructions to run in the nanoCAD 

command line. Each line of the file contains a command call (with parameters) or a 

link to another script. 

The following script processing commands are implemented: 

• SCRIPT – loads the script file and executes the instructions described in this 

file sequentially; 

• SCRIPTCALL – modification of the SCRIPT command to run the nested script; 

• RESUME – if a script is suspended while the program is active, you can use 

RESUME to continue the script; 

• RSCRIPT – repeats the last script. 

Digital Signatures 

The custom files signing (.dwg, pdf, zip, ...) with a digital signature is available. 

Two types of signing were implemented: 

• creating an internal signature when saving a file; 

• creating an external signature for any file. 

 

Commands for internal signature creating: 

• DIGITALSIGN – allows you to choose a digital certificate for digitally signing a 

file and sets up signing while saving a file; 

• SAVE - creates an internal signature during file saving; 

• SIGVALIDATE - validates the digital signature of the file. 

 

Commands for external signature creating: 

• SIGNCERTIFICATESCONTROL – allows you to choose a digital certificate for 

digitally signing a file; 

• SIGNFILE - creates a file with external signature (“FileName.FileExtension.sig”) 

for any specified file; 

• VALIDATESIGN - validates the external signature of the specified file. 

Splines 

New Spline Creation Method 
The second method of spline creation was implemented – by specifying control points. 
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New Grips 
To edit splines in the fit point mode, a new type of grips is implemented to change 

the tangent vectors direction. 

 

Rubber-band Line 
During spline creating an auxiliary rubber-bend line is displayed on the screen from 

one fit point (or control point) to another. You can also snap to this temporary dotted 

line. 

 

Snap to the First Point of a Spline 
Now you can snap to spline start point. 
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The “Simplify Spline” Command 
The SIMPLIFYSPLINE command optimizes the spline by changing its approximation 

accuracy and the maximum number of its points. 

The “Export Layout” Command 

The EXPORTLAYOUT command allows you to export all the visible objects of the 

current layout to the model space of the new drawing. 

The “Change Space” Command 

The CHSPAСE command moves the selected objects from the model space (in a 
layout viewport) to the paper space, as well as from the paper space to into the 

layout viewport. 

Dimensions 

The “Oblique Dimension” Command 
The Oblique Dimension (DIMOBLIQUE) command changes the oblique angle of one 

or more previously created dimension objects. 

The “Angle Ordinate Dimension” Command 
The Angle Ordinate Dimension (DIMAORD) command creates an angular ordinate 

dimensions. 

Printing 

Internal Raster Plotter 
The internal raster plotter is available for exporting data in raster files of supported 

formats: 
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Internal DWF and DWFx Plotters 
The internal DWF and DWFx plotters are available. 

Isometric Views Printing 
Improved printing of isometric views when specifying the plot area with a rectangular 

frame. 

Verification of third-party print settings 
Verification of print settings made in third-party programs is performed. When these 

settings are detected, the Print command displays a message. 

Improved Print Preview 
It is now possible to specify the number of copies to print in the Print Preview 

dialog. The option is not available when you print to a file. 

In the preview window: 

• Increased display speed; 

• Improved image quality; 

• Eliminated artifacts when zooming, panning and resizing the preview window 

and the Print dialog. 
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Layers 

The  “Previous State of Layers” command (LayerP) allows you to consistently 

return to the previous state of a layers. 

SHIFT and CTRL Using 
The logic of selecting a group of layers with the SHIFT and CTRL keys in the Layers 
dialog was changed. Now the selection logic corresponds to standard logic 

implemented in Windows: 

• use CTRL+click to add any individual layer in a selection set; 

• use SHIFT+click to add group of layers in a selection set. 

 

List of Layers Displaying Speed 
The display speed of the list of layers in the Layers dialog is significantly increased. 

Especially if there are hundreds of layers in the drawing. 

Check Standards 

The “Standards Settings” Command 
The STANDARDSSETTINGS command is added to open the Standards Settings 

dialog. 

Status Bar 

At now on, the button for checking CAD standards  is displayed in the status bar 

only if the standards file has been connected to the document. 

A hyperlink is added in the balloons of the standards check button to open an 

appropriate dialog box. 
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Improved Snap Logic in 3D Space 

The snap behavior in the three-dimensional space was changed. 
If a visual style with shaded faces is set and the OSNAP3DTOP variable is turned ON, 

then you can snap only to points of 3D-object behind the cursor. 

If the wireframe visual style is set, or the OSNAP3DTOP variable is disabled (= OFF), 

snap will be performed to points of all objects in a drawing: 

 

The “Add Selected” Command Improvement 

The  ADDSELECTED command can now create multileaders and dwg-tables. 
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The PELLIPSE Variable 

New PELLIPSE variable determines the type of ellipse being created: 

• if the value is 0, an ellipse object is created; 

• when the value is 1, a 2D polyline is created instead of an ellipse object. 

Editing of the Region with Its Grips 

Now you can edit the region contour with its grips. 

2 modes of editing are available: 

• the mode of moving the region by the central grip; 

• mode of region contour editing with its grips 

  

Modes are switched with a round grip. 

Clearing Invisible Proxy Objects from a Document 

The RMPROXY command get the possibility to delete proxy objects that do not have 

a graphical representation. 

 

Options 

Delays in Displaying the Command Completion List 
Amount of time that elapses before command line completion list is shown can be 
specified in the Options dialog: Command line > Use Autocomplete Additional 

Options > Completion list delay. 

 



 

24 

 

The Value of Objects Fading on Locked Layers 
The value of fading for objects on locked layers is defined by the LAYLOCKFADECTL 

variable. 

 

This value can also be changed in the Options dialog (Select > Shading objects 

> Locked layers item). 

 

Displaying of “Invisible” Objects 

In a new version of the program, it became possible to make visible “hidden” objects 
– the objects with the “invisible” attribute. By selecting the appropriate option in the 

context menu of the Drawing Manager, you can make visible a single “invisible” 

object or a group of “invisible” objects: 
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User Interface Customization 

Partial CFG-file Unloading 

In the  Customize User Interface dialog, you can unload the current partial 

configuration file. 

 

Import Shortcuts 
In the Customize User Interface dialog, the ability to import only keyboard 

shortcuts from .cuix and .cfg files has been added. 



 

26 

 

User Interface Changes 

Utilities in nanoCAD Menu 
The command for displaying the properties of a drawing, as well as the utilities for 

auditing, checking and working with a document, is added to the application menu 

and the context menu of the document tab. 
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Multiline Attributes Editing Panel 
The ATTIPE system variable is used to change the Text Format panel that appears 

to create/edit multiline attributes. 

• If ATTIPE = 0, the short variant of formatting panel is displayed: 

 

• If ATTIPE = 1, the complete panel is used: 

 

Other Changes 
• The CTRL+W key combination is used to display or hide the Select Objects 

dialog; 

• Dynamic input is available when creating a rectangle by 2 points; 

• A new toolbar Tools: 

 

• A large design work is continued in a new version of nanoCAD that improved 
the graphical interface of the program: the next package of icons was 

reworked; a number of improvements were made to the Graphite and the 

Light application visual styles. 

Text Files Import Wizard for Point Clouds 

A special import wizard dialog is displayed when importing point clouds from text 

formats. It allows you to correctly interpret the point clouds data. 
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Export 

Export to DWF, DWFx, STL and 3D PDF file formats is available. 

The  Export Point Cloud command (NPC_EXPORT) can export point clouds in a 

PLY (Polygon File Format) format. This one was developed to store 3D scanner data. 
The format allows you to store many properties of the object (color, transparency, 

normals, texture coordinates, etc.). 

Material Editor 

The possibilities of editing materials have been extended: 

• the functionality was separated into three functional bars: Material Browser, 

Material Editor and Texture Editor; 

• editing of material texture parameters is available. 
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New Features of nanoCAD 20.0 Platform 

Drawing Comparison 

File comparison feature allows you to find the differences between the contents of 

the model space in two drawings: detect objects that have been modified, added, or 

removed in the compared drawings. 
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The  Compare Files (DWGCOMPARE) 

command (the Functional Bars section on the 
Options tab) displays a functional panel with 

settings and a launch button. 

 

The feature creates a new dwg file that displays 
similar and different objects of the compared files, 

coloring them in several colors. In addition, you 
can switch off the displaying of unnecessary 

objects or set a transparency value for them. 

Click the  icon to open a dialog with information about the compared files: 
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Built-in Script Editor 

The built-in  Script Editor (SCRIPTED) allows you to create, edit and run script 

files of various formats: ActiveX (.JS, .VBS), LISP (.LSP), DCL, SCR. 

 

You can use the following keyboard shortcuts in the editor: 
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Action Shortcut 

Select All Ctrl+A 

Copy Ctrl+C, Ctrl+Ins 

Insert Ctrl+V, Shift+Ins 

Cut Ctrl+X, Shift+Del 

Undo Ctrl+Z, Alt+BackSpace 

Redo Ctrl+Y 

Go to String Ctrl+G 

Find Ctrl+F 

Find Next F3 

Find Selected Ctrl+F3 

Replace Ctrl+H 

Open Ctrl+O 

Save Ctrl+S 

Save As Ctrl+Alt+S 

Properties Ctrl+P 

Run Ctrl+R 

Find the Matching Pair Bracket Ctrl+{ 

 

For LISP scripts, an executing of the selected part of the code is implemented. To do 

this, select the necessary LISP code in the editor and click the  Run script button 

with the CTRL key pressed. 

Editor’s settings allow you to adjust the display and formatting of individual language 

elements. 
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System Variables Monitor 

The  System variables monitor (SYSVARMONITOR) displays system variables, their 

brief description and values, allowing you to edit, sort, search them and track 

changes in real time. 

 

 

Element Action 

 Save variables to a file and load from the file. It is possible to save 

both all and only pinned variables. 

 Search for variables by name. 

 

Column Value 

 Storage location: 

•  - the variable is stored in the registry. Always retains its 

value.  

•  - the variable is stored in the document. Its value changes 

only for a specific document. 
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•  - the value of the variable is saved only for the current 

session. After closing the program, the value is reset. 

•  - no storage place. The value is stored until the document 

is closed. 

Sorting is performed by clicking on the column 

heading or by selecting an item in the menu, 

which opens by a long click on the heading. 

 
 

System 

Variable 
The name of the system variable. 

 

Sorting is performed by clicking on the 

column heading or by selecting an item 
in the menu, which opens by a long click 

on the heading. 

In addition to the direct and reverse alphabetical order, the 

variables can be sorted by frequency of use (More popular) and 

time of change (Most recently) during an active session of the 

program. 

Value of 

Variable 

The value of the system variable, which can be entered or selected 

from a list of fixed variants. Gray (muted) typeface indicates 
variables with constant values. If the value of a variable differs from 

its initial value, it is displayed in blue font. In most cases, the initial 
value is given in the variable description at the bottom section of 

the panel. 

 Click in this column opposite the variable to fix the variable at the 
top of the list, regardless of the sorting method. The variable moves 

to the top of the list, the  icon appears in front of it. 

 Click in this column opposite the variable to start tracking the 

change of the variable. Turned off lightbulb  will appear, meaning 

that the variable has not yet been changed since the start of its 
tracking. If the value of the variable is changed (by a command or 

by a user), the bulb will “light up”: . 
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Undo/Redo Evolution 

Undo after Saving 
It became possible to undo the operations performed after saving a document. In 
previous versions of the program, saving the document clears the list of operations 

of the Undo command. 

Use the checkbox Undo command settings > Clear after save in the Options 

dialog. 

Preview for Undo/Redo 
A preview of result of undoing (and redoing) operations was implemented. When you 
move cursor to a command item in the undo (/redo) list, a preview of the resulting 

scene is displayed in the drawing area, which will appear after undoing all operations, 

up to the specified command. 

Undo/redo preview can be disabled with the checkbox Undo command settings > 

Generate preview in the Options dialog. 

Undo for Navigation Commands 
In this version you can include the following actions in the undo / redo list: 

• 2D navigation commands: panning and zooming operations, including those 

performed with the mouse. 

• 3D navigation commands: Orbit commands (including performed in 

transparent mode with the mouse), 3D Walk, 3D Fly, Locator using. 

You can also group sequentially performed 3D and 2D navigation operations into one 

action to undo. 

Configure these actions in the Undo command settings section of the Options 

dialog. 
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Dynamic Input 

Implemented dynamic input mechanism. 

 

Dynamic input displays the command interface near the cursor in the drawing area. 
At the right time, current prompts, command requests, input fields, lists of selectable 

keywords, dimensions of edited geometry are displayed next to the cursor. 

Dynamic input consists of three functional parts: 

• Pointer Input; 

• Dimension Input; 

• Dynamic Prompts. 

You can adjust them or switch them off in the Dynamic Input section of the Options 

dialog. 
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Dimension Input 

 

When you specify next point for a linear or an arc segment or a circle, the linear and 
angular dimensions are displayed on the screen relative to the previous point. These 

dimensions look like a dashed rubber line with a numerical field. As the cursor moves 
in the drawing area, dynamically displayed dimensions are constantly updated to 
reflect current values. By toggling the TAB key, switch to the required dimension 

value for editing it from the keyboard. 

 

 

Pointer Input 

 

When a point is requested by a command, you can enter its coordinates in the tooltip 

box near the crosshair, where the current cursor coordinates are shown. 

 

By toggling the TAB key, switch to necessary value to edit it from the keyboard. Press 

ENTER when done. 
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Dynamic Prompts 

 

 

Dynamic prompts provide an alternative way to enter command parameter values. 
In the tooltip field near the cursor, requests and prompts of the active command 

appear, necessary to complete the command. Data can be entered in the dynamic 

prompt fields instead of the command line. You can enter command keywords and 

requested numeric values. 

The list of available values and options can be expanded by pressing the DOWN 

ARROW key on the keyboard. Then choose the desired value with an ARROW keys 

and press ENTER. 

 

 

Dynamic input can be disabled by using a button  in the status bar or by pressing 

F12. 
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Dynamic UCS 

From now on, when you create an object and move the cursor over a flat segment, 
the UCS temporarily aligns with it. This makes it possible to immediately draw in the 

plane of the highlighted face without additional execution of change-UCS commands. 

This feature is available in the Dynamic UCS mode. It is enabled by default, but can 

be disabled by the UCSDETECT variable or by a button in the status bar: . 

 

 

In the Dynamic UCS mode, UCS changes its orientation when you move cursor over 

a face of a 3D solid or a flat segment of a point cloud. 
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 The Dynamic UCS works on point clouds 

with surfaces, previously recognized by 

the  Search Planes in Point Clouds 

command. 

 

The direction of the UCS axes depends on the edge that the cursor crossed when 

moving to the face. 

So, the X axis is set parallel to the 
crossed edge in the direction from the 

initial vertex of the crossed edge. The Y 
axis perpendicular to the X axis and is 

directed toward the inner part of the 
face. Z axis is set so that the right 

coordinate system is obtained. 

When you move cursor toward the same 

face through another edge, the 

orientation of the UCS axes also 

changes. 
 

    

At the first mouse click, the UCS is fixed and the first vertex of the created object is 

set. Then you can continue to draw in the selected plane. Upon exiting the object 

creation command, the UCS is reset to its original orientation. 
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External References Notification 

While working in a document, changes in the files of external references made by 
external programs are tracked. Changes in the files of external references (xrefs), 

underlays, and raster images are tracked. 

The status bar displays an indicator button of the status of external links in the active 

document. 

 

If an external link file was changed in a third-party application while working in the 

drawing, a warning message will appear and the indicator will change its status. 

 

Right-clicking on the button opens a context menu from where you can call the 

External Links dialog box or update the external links of the drawing. 

  

If the external link file was not found at all, the message appears, and the indicator 

button turns red. 

 

The XREFNOTIFY variable allows you to disable notification or change the type of 

notifications: 

0 - disable notification of changes of external link files. 

1 - display notifications in the dialog boxes. 

2 - display notifications as pop-up balloons near the status bar. 

The XNOTIFYTIME variable sets the time interval at which external link files are 

checked (in minutes). 
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Bounding Prism – Viewport 3D Clip 

For each model space viewport, you can create a bounding prism – an area in a three-

dimensional space, beyond which all the graphics are not displayed. 

 

   

 

The area is defined as a rectangular or polygonal prism with grips. The prism can be: 

1. created by specifying a contour on the screen, 

2. created on the basis of an existing polyline, 

3. based on a bounding box of selected objects. 
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The prism above the XY plane of the UCS is blue, below it is orange. The grey outline 

of the prism is displayed in the XY plane. 

 

Drag grips to place the upper and the lower prism cutoff planes. Otherwise the upper 

and lower displaying area will be unlimited. 
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For each model space viewport, its own bounding prism should be created. 

 

 

An existing prism can be changed, deleted or disabled/enabled. If the prism is 
disabled, graphics outside the prism become visible. Disabled prism object is still 

present in the model space and can be switched on later. 

To create and modify bounding prism use the  Bounding Prism (MCLIP) 

command (the Viewport Tools section of the View tab). 

Semitransparency of Edited 3D-Objects 

Now, objects edited with the Move, 3DMove, Rotate, 3DRotate, Scale, Stretch, 

Mirror, editing by grips, drag&drop commands become semitransparent during 

editing for better positioning in space. 

 

Disabled by the EDITTRANSPARENCY variable. 
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Other Improvements 

Viewport Visual Style in Extended Named View 
In this version, the Extended Named View keeps not only the section of the point 

cloud, but also the visual style of the viewport. 

Popup Menu for Multifunctional Grips 
A pop-up menu with options for multi-function grips appears when you place cursor 

at an object grip. 

 

In the new version, the parameters of multifunction grips are available not only when 
the CTRL key is pressed repeatedly, they also appear in the pop-up menu when you 

place cursor on the grip. 

The pop-up menu is implemented for grips of a line, 
arc, polyline, 3D polyline, hatch, multileader and 

spline object. 

You can configure the way to access grip options in 

the Handles > Multifunctional grips section of the 

Options dialog. 

 

 

These settings are accessed from scripts through the GRIPMULTIFUNCTIONAL 

variable. 

 

Greyscale Print Preview 
When printing in greyscale, the preview window displays greyscale image also. 
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Coordinate Filters 
Coordinate filters are entered in response to a point request and define the axes 

along which coordinates will be set. You can enter the following filters: .x, .y, .z, .xy, 

.xz or .yz. 

Coordinate filters allow you to input the coordinates of a point for each axis 

separately, specifying coordinates first along one axis, then along another. 

Coordinate filters are useful when the value along one axis is determined by one 

characteristic point of the object, and along the other axis by another point. When 
using coordinate filters, it is possible to extract one coordinate value at a time from 

selected characteristic point of an object by using a snap. 

 

For example, you need to enter the coordinates of a point, located in the center of a 

drawn rectangular window. 

In response to a point request: 

Specify point: 

1. Enter filter: .x 

The request will change its appearance. Now not all coordinates are requested, but 

only the value along the X axis: 

Specify point: >> X 

2. With the Midpoint snap activated, specify the horizontal edge of the window. 

This will define the coordinate of the point along the X axis. 

Now the coordinates for the remaining Y and Z axes are requested: 

Specify point: >> YZ 

3. We are satisfied with the mode of cleaving coordinates from a point 

simultaneously along two specified axes. Therefore, it is not necessary to enter 
any other coordinate filters. With the Midpoint snap activated, select the 

vertical edge of the window. This will define the coordinates of the point along 

the Z and Y axes. 

Improved Display of TrueType Fonts 
The display of TrueType font text was optimized, especially with its small size. 

The Startup Screen 
The Startup Screen completely redesigned. 

It became an interactive multi-functional window with a set of tabs, which allows you 

to create new documents, open existing ones, display and sort the list of previously 
opened documents, display their thumbnails, show a list of available applications with 

a description, links to training resources for each application, a list of new program 

features with a brief description. 

The AutoСlose checkbox automatically closes the startup screen on the next 

application start, if no manipulations were made in this window during startup. 
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The “About” Window 
The About window completely redesigned. It contains links to license file, trademarks 

and displays version number, build number, license status, server name and 

registration information. 

 

Comments When Printing SHX Text to PDF 
When printing to PDF, it is possible to convert SHX texts to PDF comments. 

Such comments will be created 

at the locations of text objects 

with the SHX font. Comments 
contain the full text of these 

objects. This allows you to 
search the contents of SHX text 

in a PDF document. 

To search for text in PDF 

comments, you need to activate 
the Include comments option 

in the Search settings of PDF 

viewer.  

 

Comment creation can be disabled by 

the PDFSHX variable or with the SHX 
text annotations check box in the 

PDF printer’s options. 

 

Pan in Active Paper space Viewport 
You can drag mouse through all paper space when panning in active but locked paper 

space viewport. 
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Annotative Objects 
Commands for displaying annotative objects created in third-party CAD programs are 

added to the ribbon and in the View menu of the classic interface. 

  

The current value is stored in the ANNOALLVISIBLE system variable. 
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New in Custom Command Creating 

The  Customize Interface command on the ribbon tab Manage > 

Customization > Interface opens the Customize User Interface dialog box 

where you can create new custom and virtual commands. 
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In nanoCAD 20 you can assign icons in ICO and BMP formats for custom and virtual 

command buttons. 

 

 

The standard technique for creating 
Lisp command involves: creating an 

LSP file, including it in the startup list 

of the Load/Unload Applications 
dialog, and only then, creating a new 

command in the Customize User 

Interface dialog. 

Now, the LISP expression can be 
written directly when creating a virtual 

command, without creating and 
downloading a separate LISP-file. To 

do this, select the Command line 
parameters radio-button and enter 

the LISP expression in the Keyword 

field. 

Using these commands, you can create 
custom buttons in the ribbon, panels, 

menus, status bar. 

 

 

 

It also became possible to create buttons for custom script commands. 
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